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CTP systems dBbox3 Hand Held Audio Tester

Ana Uut R

dBbox 3

Introduction — version 4 firmware

The dBbox3 is an evolution of our original dBbox designed primarily for use by sound and audio installation
engineers. The unit is fitted with a powerful digital signal processor and separate microcontroller providing huge
flexibility for future firmware updates. The unit allows monitoring, metering and generation of both stereo analogue
and AES/EBU audio from a pocket sized unit. The dBbox3 includes a simple five button menu interface to make
any test as simple as possible. With the dBbox3 you can listen to and meter AES/EBU at many sample rates,
analogue line and microphone level signals with or without phantom power. The unit can analyse sample rate,
bits, status word and errors. It can send tone at various levels and frequencies, send microphone input to
analogue line or AES/EBU output at 48kHz or 96kHz, test phantom power, test MIDI transmit and receive, read
and generate linear timecode, generate up to 80mS of delay and it even has a built in torch.

dBbox2 to dBbox3



Several ‘under the bonnet’ hardware changes have been made on the transition from dBbox2 to dBbox3.

The unit now has a more efficient power supply for longer battery life. There is also an auto switch off system. The
accuracy of the test timecode generator has been improved and the cable tester now also tests the XLR earth
wire. Improvements have been made to the MIDI circuitry and we have added a LED ‘torch’. We have increased
the loudspeaker volume and other improvements have been made for more flexibility with future firmware
updates.

Some general information

The battery symbol on the top right of the display shows if you have enough battery power for the current function.
A solid block is a full battery. The dBbox3 has an intelligent battery management system that switches off all
electronics not in use for a particular test. Different functions use varying amounts of power, generating phantom
from a 9 volt battery uses a lot of power and should be avoided for extended periods unless on external power.
The unit may be made to switch off automatically if not used for a selectable period of 1 to 127 minutes.

When on external power (via the mini USB connector) the battery symbol will change to USB.

Press < and > together to toggle the LCD display backlight on and off.

Inserting a jack into the V4 inch or 3.5mm headphone socket will cut the internal loudspeaker. Press Select and the
Up button for one second to switch the LED light on. Press again for one second to switch it off.

Meter scale may be selected to either PPM or VU for analogue inputs and PPM,VU, -18dBFS or -20dBFS for
digital inputs.

At any point in the menu system pressing Vol- and Vol+ together will return you to the main top menu.
When the volume is adjusted a ‘slider’ display will appear with visual indication of the current volume setting.

Using the menu system

Any menu item without > next to it is a selection. Just highlight the required line and press ‘select’ to jump to the
function.

Any menu item with a > next to it allows a selection of various parameters or choices. Simply scroll up or down
until your selection is highlighted, then press the > key, the highlighted area will move across to the right. Press
the up or down keys to scroll through your choices, all changes are instant. To return to the main menu just press
either < or ‘select’.

For example: to listen to a phantom powered microphone on the internal loudspeaker:

Switch on the dBbox3, you are now on the top menu. Use the up/down keys to highlight ‘Input”. Press the > key to
move the highlighter to the right of ‘Input’. Press the up/down keys to scroll through the possibilities:

Analogue

« AES BNC

o AES XLR

« SPDIF BNC
« Off

When ‘Analogue’ is highlighted press either the < key or press “Select”. The highlight will now move back to
‘Input’. Press select. You are now in the analogue input menu. Press the down key to highlight “Gain”. Press the >
key and the 0dB gain setting will be highlighted. Use the up/down keys to adjust the gain setting (+70dB to -10dB
in 1dB steps) . The setting will move just by 1dB then speed up if the button is held down. Now press either < or
“Select”.

Scroll down to “Phantom” and press the > key. Press either up or down to switch phantom on. If you have plugged
a phantom mic in and put in enough gain the mic will be heard through the speaker and will be metering on the
display.

To switch off the mic amp press “select” or the < key and scroll up to exit, then press "select”. you will be returned



to the top menu. Alternatively just press the Vol+ and Vol- keys together.
The menu system really is easier to use than it is to describe.

Audio Inputs

Access to the various facilities will be described as for example:

« Input> Analogue Gain > Where analogue input is selected and we are dealing with the gain settings.

Analogue Inputs, metering and monitoring
On the analogue input page it is possible to listen to and meter mono or stereo analogue signals using PPM or VU
metering (as selected in Setup) with a stereo phase meter and, for testing microphones, to apply phantom power.

« Input> Analogue Gain > Gain range -10 to +70dB

« Input> Analogue Phantom > Phantom power (both inputs) on or off

AES/SPDIF Inputs, metering and monitoring and analyzing

All digital inputs are essentially the same apart from the connector in use, voltage levels and impedance. They all
use the same display page so will all be described together. Input metering may be 18dBFS, 20dBFS, PPM or VU
and includes a stereo phase meter. The unit will auto switch sample rates in the range 32kHz to 96kHz.

« Input> AES BNC
« Input> AES XLR
« Input> SPDIF BNC

The examples will use AES BNC.

« Input> AES BNC Listen > Select to listen to left, right or both Audio channels.
« Input> AES BNC Errors This lists any errors that may occur on the

Digital signal. Checks are made on:

CRC Q subcode

CRC channel status

Unlock

Data validity

Biphase encoding

Parity

With no signal input some of these errors may still show as “OK’ as there is no signal to analyse or compare.

« Input> AES BNC Errors type> loop or sticky
When set to “Loop” any errors are continuously monitored so a brief error may not be noticed. When set to
“sticky” an error once set will be continuously displayed even if the signal has recovered from the error.
« Input> AES BNC Ch.Status Shows the channel status of the AES signal. Possible readings are:
Sample rate Sample rate is calculated directly from the incoming clock.
Possible displayed values are 32kHz, 44.1kHz, 48kHz, 64kHz, 88.2kHz, 96kHz, 176.4kHz and 192kHz. Any

other sample rates will be displayed as ‘??77?.



Audio bits Possible readable values 16 bit, 20 bit, 24 bit.
Emphasis On or off.

Generation Original or Copy

Copyright Yes or No.

Format Possible data types PCM, IEC61937, DTS_LD, DTS_CD.

Only while reading channel status some sample rates may sound distorted through the loudspeaker or
headphones as it's necessary to switch off some synchronising functions to efficiently calculate the sample rate.

Input> AES BNC Stat.word
This displays the first five (and most important) bytes of the AES status word in binary format.

Audio Outputs

All available output signals are the same for analogue, AES and SPDIF signals so will be described together.
Analogue signals go up to +12dBu and digital signals up to 0dBFS.

Output> Analogue
Output> AES BNC
Output> AES XLR
Output> SPDIF BNC

Audio Output Menu

Tone Access the tone menus
Int.Mic Output the built in mic.
Noise Gen. Output pink or white noise

Frame Rate> This item will only show if digital output is selected. Set to 48kHz or 96kHz as required

These examples will use AES BNC.

Output> AES BNC Tone Type> Various types of tone output are available:

Steady Continuous tone both channels.

GLITS Graham’s Line Ident Tone System. Used extensively for Stereo line identification by the BBC amongst
others.

EBU Cyclic break on the left channel, steady on the right.

Sweep Tone rising in frequency from 20Hz to 20kHz. Press Vol- or

Vol+ to start the sweep.

Left Left channel only

Right Right channel only

Output> AES BNC Tone Level> Sets the output level of the tone from -60dB to +12dB in 1dB steps. Settings
will be retained in memory.

Output> AES BNC Tone Frequency> Sets the frequency of the tone in third octave steps from 50Hz to 20kHz.

Output> AES BNC Tone OP listen> Switch to ‘on’ to enable the internal speaker and volume control for



confidence monitoring.

« Output> AES BNC Int.mic Enables the user to speak to analogue or digital outputs using the built in
microphone.

« Output> AES BNC Int.mic Gain> Sets the internal mic gain or effectively the level on the outputs.Available
settings +12dB, +6dB, 0dB, -6dB, -12dB

« Output> AES BNC Int.mic Limiter> Sets the threshold of the limiter on the outputs.

« Possible settings +12dB, +6dB, 0dB, -6dB, -12dB

o Output> AES BNC Int.mic Output> Select to left, right or both outputs

o Output> AES BNC Noise Gen.

Generates pink or white noise with a frequency range of 20Hz to 20kHz

« Output> AES BNC Noise Generator Type> Set output of the noise Generator to Pink or White noise.

« Output> AES BNC Noise Generator Level> Set output level of the noise generator from — 60dB to +12dB in
1dB steps. Setting will be retained in memory.

o Output> AES BNC Noise Generator Output> Select to left, right or
Both outputs.

« Output> AES BNC Noise Generator OP listen> Switch to ‘on’ to enable the internal speaker and volume control

for confidence monitoring.

Phantom power measurement

Phantom
Connect your phantom mic cable to Ana Out L. Phantom power will be measured on both live and neutral (XLR
pins 2 and 3) with a tolerance of +- 1 volt.

Four Wire Box

4 Wire Box

This feature is analogue only.

The dBbox3 will act as a four wire box using the internal microphone and speaker or headphones. Listen to
incoming audio and adjust the volume using Vol- and Vol+. Up. If the speaker is in use it will cut on talk to prevent
feedback, the headphones will not.

Press the down arrow to speak on the internal mic. The microphone passes through a limiter, the threshold of this
limiter is set by

Output> Analogue Int.mic Limiter>

Signal conversion

o In/Out/FX
This page allows conversion of audio signals with the addition of a limiter, gain adjustment and equalization.
Note that only 48kHz AES signals may be used in this menu.

« In/Out/FX Input> Available inputs Analogue, AES BNC, AES XLR and SPDIF.

¢ In/Out/FX Output> Available outputs Analogue, AES BNC, AES

« XLR and SPDIF In/Out/FX Gain> Gain range will be +70dB to -10dB when on analogue input (to allow for



microphone levels) and +12dB to -10dB when on digital inputs.

« In/Out/FX Phantm> Phantom power on/off. This item may only be changed in on analogue input, else it will Be
forced to off.

« In/Out/FX Limit> Switches the limiter on or off.

o In/Out/FX Lim Th> Adjusts the limiter threshold.

« Possible settings +12dB, +6dB, 0dB, -6dB, -12dB.

« In/Out/FX HF> High frequency equalization. Range -12dB to +12dB in 1 dB steps.

« In/Out/FX Mid> Middle frequency equalization. Range -12dB to +12dB in 1 dB steps. Centered around 1kHz.

« In/Out/FX Low> Low frequency equalization. Range -12dB to +12dB in 1 dB steps

MIDI

The MIDI menu is broken down into two selections, MIDI analyse and MIDI notes.

MIDI Analyse

This is used to analyse incoming MIDI data and will display the MIDI channel number (where applicable) , the
MIDI message and the associated data.

The mode or type is shown as a text description (ie. ‘system common’) and as data in blocked characters. MIDI
signals may be passed through the unit so MIDI may be in use while being analysed

« MIDI Analyse Format> Selects MIDI data to be displayed in hexadecimal or decimal.

« MIDI Analyse Clear> Clears the screen

« MIDI Analyse Oneshot> When the cursor is put over ‘oneshot’ the word will change to ‘Waiting’. When the next
MIDI message is received it will displayed on the screen and all following messages will be ignored. This is
useful for analysing a single message when many messages may be passing through. Press ‘select’ to clear

the screen and wait for the next message.

MIDI Notes

The MIDI notes page incorporates a MIDI transmitter and a MIDI receiver, they may be used at the same time.

« MIDI Notes Channel> Selects the MIDI channel to transmit the note on. Range 1-16.

« MIDI Notes Note> Selects the MIDI note number to be transmitted. Range 0-127.

« MIDI Notes Veloc.> Selects the velocity of the transmitted MIDI note. Range 0-127.

« MIDI Notes Send On Highlight this and press select to transmit your MIDI note with ‘note on’ information.
« MIDI Notes Send Off Highlight this and press select to transmit your MIDI note with ‘note off’ information.

« MIDI Notes CIr RX This will clear all data from the MIDI RX Display ready for the next received data.

The MIDI RX area will display MIDI channel, note number and velocity of the last received MIDI data. It is also
displayed at the bottom of the page in hexadecimal for analysis purposes.

More
The more menu enables selection of the Timecode reader, Timecode generator, Tone Loop, 2Wire listen and
Cable Test.

More/Read Timecode



This option reads linear timecode at 24, 25, 29.97 and 30 frames per second using the Ana in L XLR. The
timecode is also output through the Ana XLR outputs so it may be used as an ‘in line’ check. If the drop frame flag
is set in the timecode stream then ‘DF’ will be displayed at the end of the time readout. The reader will resolve
timecode down to a level of -30dBu. The timecode may be monitored and metered, the meter will follow
whichever type has been selected in ‘setup/ ana meter’. (PPM or VU).

« More Read Timecode Freeze Press select while this is highlighted to freeze the timecode display. When
selected it will change to read. Select again to restart the display

« More Read Timecode nnFPS This selects the frame rate range for the reader. Set to 25FPS for 24 or 25FPS or
30FPS for 29.97 (dropframe) or 30FPS.

« More/Generate Timecode
This generates test linear timecode at 24, 25, 29.97 (dropframe) and 30 frames per second using the Ana out L
XLR. Level is set at 0dBu.

« More Generate Timecode Start Press select while this is highlighted to start timecode generation. Generation
will start at the time displayed. When started the display will change to ‘Freeze’. Select again to stop the
timecode.

« Timecode continues to be generated at the frozen time.

« More Generate Timecode Clear This will set the timecode generated to 00:00:00:00.

« More Generate Timecode Set Starts the timecode at a pre-defined time. Select ‘Set’ then the cursor will move
to tens of hours. Press the up or down key to adjust tens of hours.

o Then press the right arrow to move to hour units and adjust using up/down. The cursor may be moved between
columns as required with the left and right keys.

« When adjusted as required press ‘select’ to return to the menu functions.

« More Generate Timecode FPS Set to generate at 24/25/29.97 or 30 frames per second.

Note: The timecode generator is not crystal locked and may lose or gain a few seconds per hour, it is intended as
a test not a reference generator, it may be however also be useful for jam syncing several devices.

More/Tone Loop

Tone loop enables output tone output and audio input at the same time. Input and output signals may be selected
to analogue or AES formats with adjustable input and output gain and adjustable frequency. This is useful for
testing operation of external equipment, checking frequency response etc. Analogue signals are output on the left
channel output XLR and input on the left channel input XLR. AES signals are output on both AES channels and
input may be selected to monitor/meter left or right channels.

« More ToneLoop Input Available inputs Analogue, AES BNC L, AES BNC R, AES XLR L, AES XLR R, SPDIF
BNC L, SPDIF BNC R.

« More ToneLoop Output Available Outputs Analogue, AES BNC, AES XLR, SPDIF BNC.

« More ToneLoop IPgain Input gain adjustable -10dBm to +70dBm on analogue input or -10dBm to +12dBm on
AES inputs.

« More TonelLoop Freq Frequency adjustable in third octave steps 50Hz to 20kHz.

« More ToneLoop OPgain Output level adjustable from -60dBm to +12dBm.

More/ 2W Listen
This will listen to and meter unbalanced audio inputs on pins 2 and 3 of the left XLR input with pin 1 as common
earth. It is not suitable for use with Clearcom beltpacks due to their call signaling system.



« More 2W listen Listen Select to listen to channel 1 (XLR pin 2),
e Channel 2 (XLR pin 3) or both.
« More 2W listen Gain Adjust input level gain from -10dB to +12dB

More/ Cable Test

Test XLR, BNC and MIDI DIN cables. XLR will indicate open circuit, phase reversed and in phase connections on
XLR pins 1, 2 and 3. BNC will test the centre (live) conductor only. MIDI DIN will check MIDI connections (DIN
pins 4 and 5). The clicking noise heard when using this function is a relay disconnecting the XLR earth in order to
test it.

More/More (select even more)
More/More/Delay

This provides a delay of up to 80mS in mono or 40mS in stereo.
If AES is used please note this feature will only function correctly at 48kHz.

« More More Delay Input> Select analogue, AES BNC, AES XLR or SPDIF BNC input(s).

« More More Delay Output> Select analogue, AES BNC, AES XLR or SPDIF BNC output(s)

« More More Delay Delay> Select up to 80mS delay in mono or 40mS in stereo. If set above 40mS and mode is
then set to stereo this will default to (and display) 40mS.

« More More Delay Mode> Set to mono or stereo delay

« More More Delay OP Mon> Switch on to monitor the delayed signal. Use the volume controls to adjust level.

More/More/Setup

This page enables the user to set metering preferences, adjust the display contrast and to personalize the dBbox3
so when switched on it will display, for example, your name and phone number.

« More Setup Ana_meter> Select all analogue metering to PPM or VU Meter scale and ballistics.

« More Setup AES_meter> Select both AES BNC and AES XLR inputs to PPM, VU, -18dBFS or -20dBFS
Metering.

o More Setup SPDIF_meter> Select SPDIF input to PPM, VU, -18dBFS or -20dBFS Metering.

« More Setup Contrast> Adjust the contrast of the display. Range 0 (lowest) to 9 (highest).

« More Setup Headphones> Set the headphone output to mono or stereo.

« More/Setup/More Setup

« More More Setup MoreSetup PPM top scale> Select top scale of PPM to UK, dB or EBU.

« More More Setup MoreSetup Spkr ana limit> Switches the speaker limiter on and off. Select to off for more
level on the speaker but note that the battery may be working very hard, especially on loud audio peaks which

may have undesirable effects on the function of the display or the box itself. Recommended setting is on.
Personalise
« More Setup MoreSetup Personalise This allows you to set up a two line message, with up to 40 characters on

the display which will be displayed when the dBbox3 is switched on. A typical use of this would be a “this unit

belongs to” message. It is important to note that when this facility has been used it cannot be changed without



return of the dBbox3 to CTP Systems. The personalise message may also be disabled if you are concerned
someone may find it amusing to put an alternative message on your dBbox3!
If a personalise message is entered when switched on the dBbox3 will display the message along with ‘Press

any key’ to start the unit.

How to personalise the dBbox3

Setup Personalise
A warning message will come up stating this cannot be undone. Press any key. Read again, then press any key.

You are now presented with a choice of:

« Exit No setup, back to the normal menu.
« Disable Disable the personalise facility

« Start Start the personalization process.

Use the left/right keys to select as required, then press “Select”.
If you select “disable” you will be presented with “You have selected to delete this facility, Are you sure?
Using the left/right key select:

« No No setup, not disabled, back to the normal menu.

» Yes This facility will be disabled and cannot be used in the future.

If you selected “Start” you will have a blank screen with just a down arrow. This is the current character position.
Either press up or down to select a character or move the arrow to the right to start in the next position and so on.
The left and right keys move the arrow either way and it wraps round to the second line. It's worth planning out 2
lines of 20 character positions before proceeding.

The left key will move the arrow back the other way. If you wish to erase a character just put in a space (next
character up from small “z”). Do not press “Select” until you have finished your message. You will then be
presented with a screen:

« Exit This will exit the personalise routine with no change

« Save This will save your message and it will be displayed on power up from now on.

Auto SwitchOff

More Setup MoreSetup Auto Switchoff Auto switch off can be set over a range of off to 127 minutes. If the unit is
on and the time elapses with no buttons on the dBbox3 having been pressed then the unit will automatically switch
to a very low current virtually off mode. To switch it back on select the power switch to off, wait half a second and
then switch it on again. When the timer is counting down it will be restarted whenever a button is pressed on the
unit so, for example, if it is set to 30 minutes and after 15 minutes a button is pressed then the timer will set back
to 30 minutes..

LED Torch
Press Select and the Up button for one second to switch the LED light on. Press Select and the Up button again
for one second to switch it off.

USB



The dBbox3 has a mini USB connector for external power and to update the firmware. Any USB outlet may be
used to power the device, a computer or even an iPhone mains adaptor using the correct mini USB lead.
Firmware updates will be available on our website, please see:

http:/www.ctpsystems.co.uk/support.html

All new firmware may be downloaded from here along with instructions and drivers.

Levels

All dB references in this manual relate to the following:

The dBbox3 ‘0dB’ output level is 0dBu, that is it generates 0.775 volts into a 10k ohm load, the most common
input impedance these days. Into a 600 ohm load it will be approximately 0.3dB lower. The dBbox3 balanced
analogue output impedance is 75 ohms. Inevitably the dBbox3 will sometimes be plugged into a source with
phantom power or something unpleasant on the line and the unit must be able to protect itself. This protection
comes at a price which includes a slightly higher output impedance in order to overcome these possibilities,
hence the variation.

If you have any firmware problems with your dBbox3 or you spot any incorrect details in our manual please let us
know so we can correct. Thank you.

« Specifications. Analogue and AES/SPDIF combined.

« Input metering — accurate to within +-0.2dB or one display segment.

« Ref. 0dBu 125Hz — 20kHz accurate to within +1dB or one display segment. 50Hz — 20kHz
« Output levels — accurate to within +-0.2dB 50Hz — 15kHz

« Ref. 0dBu accurate to within +-0.4dB 50Hz — 20kHz

o Normally within +-0.1dB at 1kHz.

« Phantom power measurement- +- 1 volt.

dBbox2 and dBbox3 firmware is the intellectual property and copyright of CTP Systems in the UK ©2014-2021

Documents / Resources

dBbox3

CTP systems dBbox3 Hand Held Audio Tester [pdf] Instruction Manual
dBbox3, Hand Held Audio Tester
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